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Keeping Up
By Paul Howard, NCTCUG
I was cutting the grass this morning, hoping that
I’d have it short enough so I could apply fertilizer
with weed killer after the rain that’s predicted.
I’ve had long wet grass clog the spreader, and thus
waste a day, the rain, and time. Then I realized,
that aside from using the Internet to try and second
guess the weather, technology sure hasn’t impacted my yard chores very much. I can’t plug in
more memory, or upgrade to a faster processor.

that can be selected to feed data into the WeatherBug application.

I mentioned that “WeatherBug” appeared on my
computer system after one of the many XP updates
I’ve loaded onto my system, while other user group
members reported not having seen this program. It
burrows in and starts on boot up, insisting on dialing up to get the latest temperature, humidity, wind
speed and direction, and a host of other weather
statistics. It gets current realtime information from
various sources close to your location — you provide your zip code. There are 25 locations within
10 miles of my house, mostly schools, but including Dulles Airport and the US Geologic Service

Lots of other weather information is available, including forecasts, weather maps, camera views,
and radar information. When you’re on-line,
Weatherbug gives a chirp and lets you know when
the National Weather Service issues an alert for
your area. Give it a try - there’s a mode that allows you to select advertisers that run in a banner
of the Weatherbug console. Those banners will
nag at times about updating to the paid version, but
it’s not that annoying, and I’ve used the adsponsored service for months. ( http://
weatherbug.com/aws/index.asp )
(Continued on page 16)
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For Beginners Only
Using The Internet To Increase Buying Power
By Charlie Paschal, Editor/Publisher, Palmetto Personal Computer Club, Columbia, SC;
Columnist, The (Columbia) State newspaper, SC

Buying on the Internet may intimidate some (not me)
but the Internet can serve other purposes, such as a
way to check prices against what you can find locally
or in other nearby stores.

There are several ways to check the price of an item,
but you must do some homework first.

Ten years ago, I can’t tell you the times I would buy
something and then two weeks later find it for $50 or
$100 less at another store in another city or town.
After the normal fussing, I’d blame myself for bad
judgment, although in those days I had no way of
avoiding it.

4 If you can’t get all that information, get as much
as you can.

Now, though, with the Internet, there is no excuse.
First, a couple of points to remember about the Internet:
4 Items, in most cases, will be less expensive on
the Internet.
4 Shipping costs must always be added into the
cost of an item.
4 In some cases, you might save on taxes, but that
depends on several factors.
4 Chain stores, such as Wal-Mart, Target or Best
Buy, usually charge the same for an item, even if
it’s in another state.
4 Some items might be refurbished or reconditioned, so make sure that the item you’re looking
at is actually new because used items will be
priced less.

4 Get the item’s name and model.

4 Plug that information into a search engine site,
such as www.google.com.
4 To get “real people” reviews of products, type
that same name into www.deja.com.
Another way to use the Internet is to check the features of different models or the features of a model
you’re thinking about buying. This can reap dividends because while doing this research, you may
find that the model you’re buying might not have the
features you really need.
Let’s take digital cameras, for example. While using
a broad search at google using only the term digital
camera might bring up thousands of hits, it might
turn up other digital cameras that have additional
features you haven’t thought about while shopping.
As an example, you probably will find a site that
lists digital cameras, feature-by-feature, giving you a
better idea of what you need to look for in a camera.
Among those hits, too, could be information that can
save you money in other ways. A good example is a
modem, a device that hooks up to a telephone line to
connect to the Internet. Most computers come with
what’s called a “soft modem,” meaning it uses the
computer’s computing power rather than its own.
Although this might sound good, it’s actually bad
because these modems are cheap, cheap, cheap. If
you’re on a poor telephone line, you might want to
get a “real” hardware modem so you can have a better chance at higher-speed connections. By reading
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the information you get on modems, you could learn
that a hardware modem is more expensive but in the
long run, will offer considerably better performance.
Sometimes buying higher quality pays dividends.

Accessibility For Everyone

This also brings up another way you can use the
Internet besides buying goods: reviews.

Many people, including a lot of Web designers,
think Web-site accessibility is only about making
sites work for blind users with screen reader software. Accessibility should be about all of us. There
is a wide range of physical conditions that can make
using the Web difficult. The Internet can be a frustrating place when you have poor eyesight, colorblindness, or trouble using a mouse. You may not
fall into any of these categories right now, but consider this statistic: 100% of Internet users are growing older. At some point, we will all need help navigating the Web.

We all know the old saying about everyone having
an opinion but on the Internet you can always find
opinions and reviews of products. Despite everyone
thinking the Internet is all about technology, the
truth is that you can find information about every
product known to man, including cars, furniture—
you name it.
The two sites mentioned above can help you find
reviews of nearly every product or real time opinions about products. Remember, though, that you
must weigh the opinions, reading several before
making up your mind. There will be some fervent
opinions on both sides.
To produce some of these, just type in the name of
the product and the word review afterwards. For example, type in Ford Taurus reviews and hit search.
Do this in each of the search engines to get not only
reviews written by professionals but reviews written
by “real people” who don’t normally write for a living. Quite often, the real people reviews give you
more information than the professional ones.
You don’t always have to buy on the Internet to reap
its benefits. Browse, search, research; all of them
can make your life more interesting—and safer.
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization of
which this group is a member, brings this article to you.

By Billy Mabray, Oklahoma City PC Users
Group eMonitor, February 2004

There are many things that can be done to make the
Web more accessible. Some of those things are already built into your Web browser. Others require
Web designers to implement accessible features on
their Web sites. If you are one of the many people
who has difficulty using the Web, you will want to
know what help is out there.
One of the biggest complaints people have is that
text is too small. It is also the easiest to remedy. If
you are using Internet Explorer, choose View>Text
Size from the top menu. Also, if your mouse has a
scroll wheel, you can hold the CTRL key and scroll
up and down to change the text size. Now, this will
not work on all Web pages – later, we will discuss
why that is and what Web designers can do about it.
The Netscape/Mozilla browser, however, can
change text size on all Web pages. Choose
View>Increase Text Size, or hold CTRL and press
the + key.
There are many shortcut keys available for those
who have difficulty using a mouse. For example,
the backspace key will take you to the previous
page, F5 will reload your current page, and ALT
plus the Home key will take you to your home page
(the page set to load when you open your browser).
Also, if you have gone back to a previous page,
ALT plus the right arrow will take you forward
again. Another useful key on any Web page is the
TAB key. You can use the TAB key (and SHIFT
(Continued on page 9)
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Internet Comparison Shopping
By Jerry Wonderly, Dayton Microcomputer Association, Inc.

Whether we’re ready or not, the Christmas season is
fast approaching. We will soon be caught up in the
rush of going from mall to mall and store to store in
search of that unique gift. However, many Americans now do much of their shopping online and the
savvy shopper uses comparison-shopping websites.
After some research, I think I’ve come up with some
sites that will be helpful as you begin to Christmas
shop online too. I’m admittedly no expert so please
consider the following as my own personal opinions.
In preparing for this article, a list was compiled of
six possible gifts from six different categories because some comparison shopping sites are more
comprehensive than others. The six theoretical gifts
include: a highly-rated Canon Powershot A70 3.2
megapixel digital camera; a best-selling book called
“Founding Brothers – The Revolutionary Generation” by Joseph J. Ellis; a top 10 PC game called
“Rise Of Nations” by Microsoft; a bottle of Estee
Lauder perfume called “Pleasures” in a 1.7 ounce
size; a board game called “Harry Potter: Heir Of
Slytherin;” and a popular golfing putter called the
“Titleist Scotty Cameron Studio Design 1.5.”
Next, a list of comparison-shopping websites was
put together. As with last year, some of the popular
sites have been swallowed up by their competition.
Deal Time, for example, is now Shopping.com and
Epinions is now run by Shopping.com while Lycos
Shopping uses the Bizrate search engine. Strangely
though, affiliated sites don’t always return the same
merchant results and even the price results can vary.
At any rate, the following comparison shopping sites
were used in my research:
Lycos shop.lycos.com/,
BizRate www.bizrate.com,
Price Grabber www.pricegrabber.com,
Shopping.com www.shopping.com,
Epinions www.epinions.com,
My Simon www.mysimon.com,
Yahoo http://shopping.yahoo.com,
Value Find www.valuefind.com,
Shop Best www.shopbest.com,
NexTag www.nextag.com, and
Price Scan www.pricescan.com.

An improvement over last year is that most of the
comparison-shopping sites now have merchant reviews, and automatically compute tax and shipping
to get an accurate display of true pricing. These include Lycos, BizRate, Price Grabber, Shopping.com,
Epinions, Yahoo, and NexTag. My Simon and Price
Scan don’t compute tax but do for shipping and also
have merchant reviews. Shop Best and Value Find
have unusual sites in that the results usually took me
to only one vendor to choose from. Shop Best had a
very slow search engine and Value Page’s frames
are cumbersome and wouldn’t react properly when
clicking links. However, overall, most of the sites
worked extremely fast, were laid out well, and offered several categories and stores to choose from.
Many online merchants are listed on multiple comparison-shopping websites. Their prices often vary
from site to site though so it pays to search more
than one comparison engine. Many sellers offer free
shipping. As with brick-and-mortar stores, use good
judgement when deciding which vendor to buy
from. Don’t be hesitant about getting seller information from the Better Business Bureau at
www.bbb.org/ . Also, consider looking for coupons
and discount codes from websites like Amazing Bargains www.amazingbargains.com, Deal Catcher
www.dealcatcher.com and Deal Of Day
www.dealofday.com.
Here are the results of my make-believe shopping
trip:
On the camera, NexTag had the lowest price from a
merchant called Dbargains at $240 plus tax and shipping. Unfortunately, you don’t know what the tax
and shipping are until after you’ve completed all of
the online purchase orders. The next lowest price on
the camera came from a Yahoo vendor called
Rush4Digital. They are selling it for a total price of
$264.80. However, Rush4Digital is an unrated merchant at the time of this writing. My Simon’s vendor, Beach Camera, offers the camera for $269.00
plus tax, if any. Beach Camera
www.beachcamera.com appears on many of the
comparison search sites.
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[DataBus Editor’s Note: Whenever purchasing
electronics over the Internet, be sure to ask the
vendor if the item you want to purchase comes
with a valid U.S. warranty. Sometimes the very
lowest prices found in searches are for “gray market” goods that were intended by the manufacturer
to be sold overseas and thus do not carry a U.S.
warranty (and, infrequently, may not even have an
owners manual written in English). The lack of a
manufacturer’s U.S. warranty should only be a
problem if you need warranty service so every
buyer must decide for himself whether to assume
the lack-of-warranty risk with some gray market
merchandise in exchange for a potentially lower
price. See what the New York Better Business
Bureau has to say about gray market merchandise
at http://www.newyork.bbb.org/library/publications/
subrep45.html.]
For the book, Lycos and Bizrate bested the competition with identical deals of $9.19 with tax and
shipping included from Overstock
www.overstock.com. I’ve bought from Overstock
before and have had good experiences.
As far as the PC game, Yahoo had the lowest price
at $37.95 total from a company called Purplus
based in California. They have a high merchant
rating on Yahoo.
Shopping for the perfume led me to the lowest
price at Price Grabber’s LuxNY.com based in New
Jersey. They offered it for a total price of $34.94.
The drawback is that LuxNY is an unrated merchant. Shopping in the fragrance category on all
of the comparison shopping sites was a bit unusual. None of them formulated tax and shipping
for some reason.
Next, I looked for the Harry Potter board game.
Most of the search sites came up with nothing.
Only Lycos, BizRate and Yahoo had listings. The
lowest price was found on Lycos and BizRate at a
merchant called TovBid.com. They sell the board
game for $8.99 with free shipping. There’s no
mention of sales tax.
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Lastly, the Titleist putter was kind of hit or miss.
Five of the sites either didn’t have a category of
Sports or just didn’t list this putter. Of those that do
have merchants selling this putter, Price Scan has a
store called Golfalltheway who lists it for $219.99
plus tax and shipping. Yahoo’s Need2Golf.com
sells the putter for a grass blade less at $219.00 plus
tax and shipping.
In conclusion, I was pleased overall with the improvement of the Internet comparison-shopping
experience over last year. There are several good
competitors out there with many reputable stores in
their listings. It is pretty easy to navigate their sites
and most of them allow you to sort the results by
total price. This year we can be spared some of the
aggravation of running from mall to mall and store
to store in search of that perfect gift by doing at
least some of our shopping online. But, you want to
know something? Even if I do find all of my gifts
online, I think I’ll still venture out into the madness
of the store crowds just to get that Christmas feeling.
Then again, I might just stay home and watch that
“Charlie’s Angels” Christmas Special…
Happy Holidays, everyone.
This article was originally published in The DataBus, newsletter
of the Dayton Microcomputer Association, Inc. (http://
www.dma.org/ ). Permission is granted to non-profit organizations to reprint or quote any material contained herein (except
that which is copyrighted elsewhere) provided credit is given to
the author, Dayton Microcomputer Association, Inc. & The DataBus.
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization
of which this group is a member, brings this article to you [Dec
2003].
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To Upgrade or Not to Upgrade!
By Timothy Everingham, TUGNET teveringham@acm.org

To upgrade or not to upgrade, that is the question.
Whether it is nobler to upgrade the computer you
have or to put aside the invested fortune of your current computer and get a new one? Or yet do you
even need to put your cash into computer hardware?
Even Shakespeare didn’t have to deal with these
questions, which in recent years have become even
more complicated to answer.
Where you should start is by determining what your
present and future needs and wants are going to be.
Don’t try to project over five years. I am not talking
about what hardware you may drool over, but what
you will want or need to do with your computer.
Will it be word processing; web surfing; email;
burning CD and DVDs; database or list management; software development; photo, graphics, video
editing and creation; or something else? Then you
look at the application software that will accomplish
those tasks. Also look at how long will your current
application software and operating system(s) be supported by the manufacturer (Windows 98 will no
longer have support and patches available after December 31, 2003). Also, if you have software that is
known to be troublesome, like Windows ME, the
need or desire to upgrade it should be considered.
Then you look at the system requirements to run
these applications: hardware, operating system, and
other supporting software (software that is required
to be installed on your system in order for your application to run).
Remember that the companies want to sell you the
software or hardware, resulting in the minimum software requirements listed being as low as possible
and may not reflect real world conditions. If you
have a system that is exactly listed as the minimum
system requirements (it is the minimum system requirements if only one is listed) consider that this
product will run extremely slowly and crash at
times. Some manufactures list both minimum and
recommended system requirement, and you do not
want to be too far below the recommended requirements. Also, some system requirements listed do
not change the RAM requirements for different operating systems. They list as minimum RAM the one
for the oldest operating system. A program may run

on Windows 95, 98, 98 SE, ME, 2000, and XP; but
the amount of RAM needed in reality is more for
Windows 98, 98 SE, and ME than Windows 95 and
more for Windows 2000 and XP than Windows 98,
98 SE, and ME.
There are some general guidelines. If you have a
Pentium II computer, AMD equivalent or older and
are doing anything else than word processing, simple web surfing and email you are looking at having too many things needed to upgrade for it to be
worthwhile. With Macintosh or notebook computers, upgrade options are more limited than desktop PCs so, unless it is fairly new, you should be
looking at getting a new computer. Also, you have
to look at how many of your computer’s components are close to or past their expected lifetimes.
If your computer’s components are five years or
older, your computer is living on borrowed time.
Where the upgrade option looks better is with Pentium 3, Pentium 4 or Athlon-based desktop computers. However, software activation has made this
more complicated. With activation the software
takes a snapshot of your computer’s hardware configuration. If you try to run it after doing too many
upgrades the software decides that it is not the
same computer; violating the software license and
shuts itself down. You then have to go to the software manufacturer and try to convince them that
the computer you upgraded is not a new computer.
The most famous of the programs that includes this
feature is Windows XP, but there are a growing
number of application software packages that also
have this feature.
Of course this has bred a lot of fear, uncertainty
and doubt (FUD) about upgrading computers,
which the people who sell new computers are
happy to take advantage of. If you do a combination motherboard (main circuit board) and processor replacement, activation should be a problem for you.
If your current computer fits your system’s requirements of your expected needs and wants, congratulations; you are done without having to spend any
money.
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However, if you still are considering upgrading, the
next thing you want to do is get out your motherboard manual (may be contained in computer manual). It will tell you what components can be installed on it. If you can’t find your manual, there is
likely to be a PDF of it on the manufacturer’s website. While you are there check to see if there are
any BIOS updates available that may give the motherboard new features that you may need. If the
motherboard does not support the processor; type,
speed or amount of RAM; or the type of plug-in card
(AGP, PCI, EISA, ISA) you want to install, you will
have to install a new motherboard that will. For
drive (IDE, ATA, SATA, SCSI), IEEE 1394
(Firewire), and USB interfaces you can get plug-in
cards instead of getting a new motherboard.
Upgrading your RAM is probably the thing that can
be most effective in putting off the need to buy a
new computer. The others would be a new video
card and a new hard drive.
Installing a CD or DVD R/RW drive is also a good
option in order to backup things on you hard drives
and being able to take data and media files off your
drives that you use infrequently.
Don’t forget to calculate your power requirements
and have the case be able to fit the motherboard.
After you make up a list of your proposed upgrade
parts, add up the cost of them. Then compare this
cost to the cost of a similar system to what your upgraded system would be. If you are doing a lot of
upgrading you will find that the totally new computer will be close to or cost less than the cost of
upgrading (there is a discount for buying an entirely
new computer rather than just the parts of one). If
you find yourself in this position you should lean
toward buying a new computer. With this type of
consideration you should also be looking at how you
will transfer data and applications from your old
computer to your new one (remember software activation issues).
With AMD releasing their Athlon 64 bit desktop
processors, one of the issues in upgrading or buying
a new computer is “will I need a 64 bit processor.”
For most people the answer is not until the later part
of this decade. To get the most out of a 64 bit processor you need 64 bit applications running on top of
a 64 bit operating system. Of course if you have a
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Mac G5 system running Panther (Mac OS 10.3) and
some of the recent versions of the high level Apple
content creation applications you are already there,
but for the PC world only 64 bit applications programs now are very high level server based or scientific applications.
There is 64 bit Linux, but the Windows XP version
is still in beta and won’t be out until spring 2004.
There will be 64 bit versions of some games in
2004, but do not look until 2005 for a significant
amount of 64 bit software for Windows XP. Because there will be a lot of 32 bit computers around
for a while there should be plenty of 32 bit software. The 64 bit Athlons and what rumors say Intel
is developing as a 64 bit desktop processor will be
able to run 32 bit applications well, which should
also keep the 32 bit software market healthy for
quite a while. So unless you are a high level gamer,
run high-level scientific or content creation applications, or run Macs you should wait on getting a 64
bit processor computer.
Making the decision on whether to upgrade your
current computer or buy a new computer has become more complex than it was a few years ago. A
systematic step-by-step approach is appropriate.
First determine your needs, then what will support
filling those needs, and then weigh the costs of upgrading or buying new. May the wisdom of the
Great Elizabethan Bard be upon you, resulting in a
fruitful bounty of computer buying.
Timothy Everingham is CEO of Timothy Everingham Consulting
in Azusa, California. He is Vice Chair of the Los Angeles Chapter
of ACM SIGGRAPH and is also on the Management Information
Systems Program Advisory Board of California State University,
Fullerton. In addition he is the Vice President of the Windows
Media Users’ Group of Los Angeles. He is also part-time press
in the areas of high technology, computers, video, audio, and
entertainment/media and has had articles published throughout
the United States and Canada plus Australia, England, & Japan.
He is a member of TUGNET. Further information can be found
at http://home.earthlink.net/~teveringham
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization
of which this group is a member, brings this article to you.

www.nctcug.org

Page 8

The NCTCUG Journal

June/July 2004

Essentials for that New Computer
By Ira Wilsker

According to preliminary sales figures, computers
were among the most popular items purchased this
holiday season. Straight out of the box they may be
a joy, accompanied with confusion, and some mild
fears. Experience and familiarity will resolve most
of the confusion, but some common essentials may
help eliminate many of the fears.
Almost all new computers straight from the box
were most likely manufactured prior to the release
of the latest security patches, and will require the
downloading and installation of all critical updates.
Likewise, most computers recently made to order
will not have the latest operating system updates. If
operating system software was purchased separately, it also will not be up to date. It is imperative
that once set up, if internet access is already established, that the user of a Windows computer immediately goes to windowsupdate.microsoft.com and
download and install at least the critical updates
listed. Other non-critical updates listed may be
downloaded and installed when desired, but the
critical updates must be installed immediately.
Another absolute essential for that new (and old,
too) computer is antivirus software. While many
new computers come with a limited time trial version of some antivirus product installed, there is no
necessity to renew that particular product when it
expires. There are many excellent titles available,
often at spectacular prices after rebates. In the retail
market, the sales leaders are Symantec’s Norton
AntiVirus (often bundled with other Symantec Norton titles), and Network Associates’ McAfee Antivirus (also often bundled with other McAfee products). Many other excellent titles are available either at retail from the local stores, or for download.
If holiday bills are a pressing problem, one of the
free antivirus products may be appropriate. One
commercial bundle, including antivirus, firewall,
and popup killer is Computer Associates eTrust EZ
Armor Security Suite, available for a limited time
as a free (for personal use) download. This full featured commercial product ($50) is currently being
made available for free download from www.myetrust.com/microsoft as a promotion cosponsored by
Microsoft’s security division. The free download

includes a year of free updates. Once the year is up,
the user will have the option of renewing for another
year at the then current license fee. Other free (for
personal use) antivirus software is Avast available
from www.avast.com, and AVG downloadable from
www.grisoft.com.
With today’s risky cyber environment, a firewall has
also become an essential product for new (and old)
computers. A firewall isolates your computer from
hacker attacks over the internet, and also provides
some protection from Trojans sending out information. While often bundled with antivirus software,
many times it must be installed separately. Commercial firewalls from McAfee and Norton are available locally, as are other firewalls. There are also
several excellent firewalls available for free (for personal use) by download. My personal choice is Outpost, available from www.agnitum.com. The single
most popular firewall in use is Zone Alarm,
www.zonelabs.com.
Also essential is a good anti-spyware program to
protect your personal privacy and security. One of
the most popular and highly rated spyware detection
and removal programs is Spybot Search and Destroy, available for free download from www.safernetworking.org. This program also includes an
“immunize” function that will offer some protection
from much of the spyware that is common on the
net. The leading commercial spyware protector is
PestPatrol, available for download from
www.pestpatrol.com. As with antivirus and firewall
software, anti-spyware software is frequently updated by the publisher, and updates must be
downloaded and run frequently in order to maximize
protection. One proviso; never purchase antispyware software from popup ads or spam mail, as
they are often fraudulent or of low quality, and only
encourage more spamming.
Something often neglected with that new (or old)
computer is power protection. The electricity coming into our homes is often “dirty”, with electrical
noise and power fluctuations, and these events may
damage the sensitive electronics in our computers.
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(Continued from page 8)

(Continued from page 3)

At a minimum, a good surge suppressor (not a simple power strip) is a necessity to protect the computer and its peripherals from electrical damage.
Surge protection is measured in “joules”, and the
more joule capacity, generally the better the protection. Even better is a good quality “UPS” or uninterruptible power supply, which in addition to providing clean power to the computer and its peripherals, can also safely power the computer for short
periods of time in the event of a brownout or power
failure, allowing for a safe and orderly shutdown,
without losing data or damaging equipment. If a
UPS is in your future, make sure it has enough
power for your system. All surge suppressors and
UPS devices should also have a UL1449 rating, an
indication that it meets minimal feature and safety
standards.

plus TAB to go in reverse) to quickly navigate forward through all the links and form fields on a
Web page. Once you have tabbed to a form element, other keyboard shortcuts may come in
handy. For drop-down boxes, you can use the up
and down arrows to highlight your selection. For
radio buttons or checkboxes, use the space bar to
select your choice. If you are using a recent version
of Netscape/Mozilla, you can also use “Find As
You Type.” Start typing at any page and it will
automatically do a search for what you are typing
on that page.

Internet access has become almost universal, and
has switched from a geek luxury, to almost everyone’s necessity. Generally avoid the “deals” that
are often preinstalled or bundled with new computers, especially for some of the overpriced national services. There are several excellent local
internet service providers (ISPs) that typically offer
service superior to many of the well know national
providers, but at a lower price. If dialup service is
wanted, check with such fine local companies as
Eonet (www.eonet.net ) or EXP Internet Services
(www.exp.net ). Broadband is available via satellite
from EXP, DSL from SBC, or cable via Time Warner or your local cable company. One proviso; if
the broadband provider is offering a “12 month special price”, find out what it will cost after the trial
period is over.
Ira Wilsker is the Advisor for Region 8, APCUG Representative
& Bylaws Chair for the Golden Triangle PC Club, a columnist for
The Examiner in Beaumont, Texas, and has two radio shows.
He also graciously shares his articles with the APCUG editors.
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization
of which this group is a member, brings this article to you.

Some people, particularly the colorblind, find Web
sites hard to use because the color of the text does
not contrast enough with the background colors. If
the color scheme of your favorite Web site makes it
difficult to read, you can override that as well. You
will find this under Tools->Options or Edit>Preferences, depending on your browser. You can
set your default fonts, font sizes, and page colors.
You can also specify that your defaults always
override what is set by the Web page.
While these browser features can be helpful, there
is still much Web designers must do to make their
site accessible to the widest possible audience. A
good example is text sizing. If Web designers use
fixed text sizes – sizes that specify an absolute unit
of measurement, such as points or pixels – on their
pages, Internet Explorer users cannot change their
text size as I described earlier. Web designers can,
and should, use relative text sizes to make their
pages more accessible. Designers who prefer to use
absolute sizes for text should provide a “style
switcher.” This is a link on the page that allows the
site’s visitor to make the text bigger and saves that
preference in a cookie.
Another accessibility feature that some designers
use is access keys. These are just like the shortcut
keys I mentioned earlier; except they are defined by
the Web page you are on. For example, the designer
could define ALT plus 4 to take you directly to the
search function. If you visit a site regularly and
know their access keys, they can be useful.
Web designers should also use labels for forms.
(Continued on page 14)
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Computer Viruses And Spam Ruled In 2003 — Be Prepared!
By Ira Wilsker

The final statistics on spam emails and viruses have
been released by several organizations and companies, and it was not a good year for computer users
who had to deal with them. Through awareness of
what happened last year, we may be better prepared
to deal with what we may encounter in 2004.

attempt to slip by the spam filters commonly used, the
spammers uses over 50 variations of the spelling of
Viagra, according to Commtouch. They also reported
that 28% of all spam contained some form of trickery
in the subject line in order to penetrate the spam filters, and be delivered to the recipient.

Even though President Bush signed the “Can
Spam” act, and it recently went into effect, the
spam tracking companies have found no decrease in
the amount of spam emails being sent, and in fact
there are indications that it is still increasing at a
rapid rate. According to the e-mail filtering service
Brightmail (www.brightmail.com), the percentage of
all emails in December, 2003, that were spam was
58%, compared to the January 2003 rate of 42%, a
substantial increase. Of the spam filtered in December, Brightmail determined that 21% was for
products advertising general goods and services,
18% was financially oriented, 18% was adult oriented, 9% was for outright scams, 6% each for
health, leisure, or internet related, 3% was spiritual
or religiously oriented, and 3% were for clear
frauds.

Far more destructive than spam mail was the proliferation of computer viruses, worms, Trojans, and spyware. According to the antivirus software company
Panda ( www.pandasoftware.com), over 3700 new
viruses and worms, including variants, appeared in
2003, which was about a third more than appeared in
2002. Documented and projected damage from these
digital vandals was enormous. The British security
company “mi2g” (www.mi2g.com) calculated that the
most damaging viruses and their variants of 2003, in
terms of dollars of damage around the world, were
Sobig ($36.7 billion), Klez ($19.4 billion), Yaha
($11.3 billion), Mimail ($10.5 billion – and still very
active in 2004), and Swen ($10 billion).

The marketing research and information company
Synovate (www.synovate.com) found that the average American received an average of 155 spam
emails per week, for each email account used. One
out of five Americans received over 200 spams per
week, in each account. Statistically, men receive
more spam than women each week, 164 compared
to 147, and there is no major difference in the rate
of spam based on age ranges. Geographically, people living in the northeast received the fewest spam
emails at 131 per week, while those of us living in
the south received the most at 163. While many
computer security experts have stated that the best
way to fight spam is to simply delete it, 11% acknowledged having a transaction initiated by a
spam mail.
The commercial spam filtering company
Commtouch (www.commtouch.com) reported that
the single most common subject used by spammers
was “Viagra”, or a substitute for Viagra. In order to

Mi2g also saw, “a meteoric rise in electronic crime:
business interruption, financial fraud, “phishing”
scams, extortion demands post distributed denial of
service attacks, espionage and mass spam campaigns.” They attribute much of this increase to
global criminal syndicates, and extremist group activities, the 2003 rate being several times more than in
2002. According to “mi2g”, the most frequent victims were home users, and small to medium businesses. Users of broadband internet access were more
frequent targets than dialup users. There also was a
dramatic increase in “pfishing” and other elaborate
scams to ensnare victims into disclosing sensitive personal and financial information through fraudulent
email and websites appearing to be authentic banking,
retail, or other commercial websites. Many customers
of major banks, retailers, credit card companies, and
online services were duped into providing their information to thieves who used that information to conduct financial transactions, steal their identities, hijack
their internet access for nefarious purposes, or commit
other criminal activities.
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Mi2g also predicts that 2004 will see a worsening
of cyber problems, with the rate of spam increasing
to 66% of all email (despite recent US and European laws designed to restrict the practice), spam
costing the world economy $60 billion in lost productivity and other costs. Mi2g also predict that
there will be a greater merging of spam, viruses,
worms, and Trojans in 2004, where personal computers hijacked by viruses and worms will be used
to generate spam at far higher numbers than in
2003, or attack other computers. Where virus writers used to be vandals seeking notoriety, 2004 will
see a dramatic increase of viruses and worms created for financial gain, identity theft, or infrastructure attack, with some of the most dangerous being
politically motivated. It is predicted that while
much of the politically motivated “hactivism” will
originate in Moslem countries, with unofficial reprisals from American, British, Indian, and Israeli
hackers. “Pfishing”, the attempt to steal sensitive
personal information by tricking the victim into
thinking that he is responding to a legitimate request from his credit card company, bank, or retailer with which he has a relationship, is expected
to continue to increase, resulting in a continued loss
of confidence in our established institutions.
Our personal risks can be reduced by using common sense, deleting all spam and other questionable
emails without opening them, using updated antivirus, firewall, and anti-spyware software, and
never disclosing personal information without verifying the necessity and destination of that information.
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Don't Forget
System Restore
By Charlie Paschal, PPCC

Viruses are always a threat, but did you know that one
can “return” without warning if you don’t turn off one
Windows XP feature when cleaning up from a virus?
One of XP’s great features is System Restore that can
take your system back to a time when it was running
better. I’ve used it countless times to return an illacting system back to a healthy time.
What if, though, you get a virus? Because System Restore can contain system settings that will restore the
virus itself, it should always be turned off before you
remove a virus.
To do that:
4 Right Click on My Computer and select Properties
and left click. Click on the System Restore tab and
check the box labeled “Turn Off System Restore
on all Drives.”
4 Then, clean up the virus and reboot. Don’t forget
to turn System Restore back on after cleaning up
the virus.
There is no restriction against any non-profit group using this article
as long as it is kept in context with proper credit given the author.
The Editorial Committee of the Association of Personal Computer
User Groups (APCUG), an international organization of which this
group is a member, brings this article to you.

As the gruff sergeant on the “Hill Street Blues” said
at the end of every roll call, “Be careful out there!”
Ira Wilsker is the Advisor for Region 8, APCUG Representative
& Bylaws Chair for the Golden Triangle PC Club, a columnist for
The Examiner in Beaumont, Texas, and has two radio shows.
He also graciously shares his articles with the APCUG editors.
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization
of which this group is a member, brings this article to you.
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Is That a PC in Your Pocket/Purse?
By Lee Schwab (KISS = Keep It Simple Schwab )
Napa Valley Personal Computer User Group, Inc., California

Hewlett-Packard
iPAQ 3800 series
For some people, the Pocket PC (PPC) is an incredibly useful tool while other people are not familiar
with the Pocket PC. Some people confuse the
Pocket PC with a Palm which is similar in appearance but is a different device that uses the Palm operating system. Below is an overview of what is included in a Pocket PC and how it helps me organize
and simplify my life.
The Pocket PC uses a scaled down version of the
Microsoft Windows operating system which is
called Microsoft Windows Mobile 2003 (replaced
Microsoft Pocket PC 2002 in June 03). Pocket PCs
ship with lots of software, are very powerful, lightweight (4-7 ounces), small enough to carry in your
pocket or purse (approximately 3” wide and 5”
long), and easily synchronize with your desktop or
notebook PC.
Here are some of the Pocket PC features:

ActiveSync: This third party software automatically synchronizes the data on your Pocket PC
with your desktop or notebook PC. You can also
use it to transfer files between the devices. Because I use the Pocket PC extensively, I synchronize them almost every day.
Calculator: Use it as you would any simple math
calculator. Use it to figure the tax on a purchase,
the unit price of grocery items, the percent of a
discount, tips, etc. Third party calculators are also
available for more sophisticated or specialized
calculations (i.e., financial, scientific, statistical).
Calendar: Keeps track of your appointments
(who meeting with, where to go, what time, and
notes). You can also set up reoccurring appointments, a reminder alarm, or cut and paste appointments. Information can be viewed by day (with a
choice of two formats), week, month, or year.
Communications: Wi-Fi and/or Bluetooth may
be included in the Pocket PC or added using the
SD (Secure Data) or CF (CompactFlash) slot.

Washington Area Computer
User Group (WAC)Meetings

Contacts: Use to organize address book information (i.e., name, address, phone, email).

WAC Meetings will be held on June 19 and
July 10 (NOTE: 2nd Saturday!), 12:30 PM to
3:30 PM. at the Fairfax County Government
Center, 12000 Government Center Parkway,
Fairfax, VA
You do not need to be a member to attend. For
more information on WAC meetings and events,
call the WAC AnswerLine (voice) at (703) 3707649. Also see WAC’s Web Site at
http://www.wacug.org/
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Excel: This Pocket version of Excel supports 100
functions and formulas, rows, columns, and spell
checker. Use it to keep track of expenses when traveling, rosters, fundraisers, etc.
Expansion: Many Pocket PCs include slots for CF
(CompactFlash), SD (Secure Data), and/or PC
Cards. Use them to add memory, a camera, communications capabilities, etc.
Find: Search the entire Pocket PC or a specific area
(i.e., calendar). Use it to find a contact, a specific
appointment, something in a Word or Excel document, etc.
Games: Solitaire and jawbreaker are included with
the Pocket PC. I am not a gamer but there are lots
of third party games available.
Inbox: An email application that lets you send, receive and synchronize email.
Infrared beaming: Beam information between devices. My husband and I beam appointments and
documents between our Pocket PCs.
Internet Explorer: This software program is included on the CD-ROM that accompanies the
Pocket PC.
Memory: Pocket PCs come with 32-128MB built
in RAM and 32-64MB ROM.
Microsoft Reader: This eBook reader can be used
to read electronic books. Use it to read the Pocket
PC manual, books that are on the accompanying
CD-ROM, or books that are downloaded. It includes search capabilities to help find a section or
word in the eBook.
MSN Messenger: Instant Messenger application.
Notes: Create handwritten or typed notes, drawings,
or make a short voice recording.
Pictures: View your .JPG pictures in thumbnail or
full screen. This is a good place to keep an electronic picture of your spouse, children, or special
events because it can easily be updated and the
edges do not get frayed.
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Power: Many Pocket PCs include a main battery,
back up battery, and power cord for external power.
The suspend mode and brightness levels can help conserve battery life so the Pocket PC can be used all day
without a charge. If the Pocket PC battery is allowed
to run all the way down, data may be lost. It is recommended to fully charge the batteries every night.
Price: Depending on features and manufacturer, the
prices range from $199 – $649.
Processor: Chips (Intel, Samsung) and speeds (200400 MHz) vary depending on the device manufacturer.
Screen: Most screens are 3.5" (measured diagonally)
and are Transflective TFT or Reflective TFT.
Tasks: Keep track of your “to do” or “honey do”
tasks. You can prioritize the tasks so the most important tasks will be at the top of the list.
Text Entry: You can enter text using the software
keyboard, block recognizer (graffiti), letter recognizer,
or transcriber (cursive, print, or mixed handwriting
recognition). As you enter text, words are suggested to
help you complete the words. Some Pocket PCs have
built in miniature keyboard where your thumbs are
used to enter or you can purchase a foldable keyboard
(Targus makes good and sturdy keyboards).
Voice Recorder: Make short recordings and playback
using the Notes application.
Windows Media Player: Use to play MP3 or Microsoft Audio Format music, or Microsoft Video Format
videos.
Word: The Pocket version of Word is incredibly useful for keeping reference documents, taking notes in
meetings, writing articles, keeping shopping lists, etc.
The Pocket PC also includes lots of systems software
(Asset Viewer, External Keyboards Functions Support, File Explorer, Infrared OBEX beaming, Server
Sync Client, setup/configuration utilities, Terminal
Server Client, VPN Client, etc.).
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Ergonomic Gizmos
by John R. Chait D.C., drchait@hotmail.com, Sarasota Personal Computer Users Group, Inc.,

How Do You Use Your Laptop?
Are you an occasional user who works on your laptop for short periods of time, or are you a full-time
user with the laptop as your main computer? Occasional users will have less ergonomic risk of problems developing than full-time users.
Laptop Posture — laptops violate basic ergonomic
design requirements, so using a laptop is a tradeoff
between poor neck/head posture and poor hand/wrist
posture.
Occasional Users — Find a chair that is comfortable
and that you can sit back in. Position your laptop in
your lap for the most neutral wrist posture that you
can achieve. Angle the laptop screen so that you can
see it with the least amount of neck deviation.
Full-time Users — Position this on your desk in front
of you so that you can see the screen without bending your neck. This may require that you elevate the
laptop off the desk surface using a stable support
surface, such as a computer monitor pedestal. Use a
separate keyboard and mouse. You should be able to
connect a keyboard and mouse directly to the back of
the laptop or to a docking station.
Use the keyboard on a negative-tilt keyboard tray to
ensure a wrist neutral posture. Use the mouse on an

adjustable position mouse platform. The design of
laptops violates a basic ergonomic requirement for a
computer, namely that the keyboard and screen are
separated. In the early days of personal computing
desktop devices integrated the screen and keyboard
into a single unit, and this resulted in widespread
complaints of musculoskeletal discomfort. By the late
1970’s a number of ergonomics design guidelines
were written and all called for the separation of screen
and keyboard. The reason is simple: if the keyboard is
in an optimal position for the user, the screen isn’t and
if the screen is optimal the keyboard isn’t. Consequently, laptops are excluded from current ergonomic
design requirements because none of the designs satisfy this basic need. This means that you need to pay
special attention to how you use your laptop because
it can cause you problems.
Copyright 2003. This article is from the October 2003 issue of the
Sarasota PC Monitor, the official monthly publication of the Sarasota Personal Computer Users Group, Inc., P.O. Box 15889, Sarasota, FL 34277-1889. Permission to reprint is granted only to other
non-profit computer user groups, provided proper credit is given to
the author and our publication. We would appreciate receiving a
copy of the publication the reprint appears in, please send to above
address, Attn: Editor. For further information about our group,
email: admin@spcug.org/ Web: http://www.spcug.org/
There is no restriction against any non-profit group using this article
as long as it is kept in context with proper credit given the author.
The Editorial Committee of the Association of Personal Computer
User Groups (APCUG), an international organization of which this
group is a member, brings this article to you.

(Continued from page 9)

Labels make the text next to a form field clickable,
just like the field itself. For example, if a form has a
checkbox that reads, “Click here to subscribe,” and
that text is set as a label, the user can click anywhere
on that text to check the box. It can be very helpful to
have a larger target when trying to click things with a
mouse.

We still have a long way to go before the Web is
accessible to everyone. But now you know some of
the helpful features you have at your fingertips already, and you know what to ask for from the Web
sites you frequent. Hopefully, as users learn what
they can do, and designers learn what they need to
do, we can all enjoy the Web a little more.

Billy Mabray and his wife, Angela, own Smart Goat, a local software development and web design business. They are members
of the OKCPCUG. Comments or questions on the article are
welcome and can be addressed to: billy@smartgoat.com.
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization
of which this group is a member, brings this article to you.
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Magazines

I bought Hewlett Packard iPAQ 3800 series Pocket
PC in 2001 and my husband is using it now. This
year I bought a DELL Axim5 but I would not recommend a DELL because the screen was badly
scratched within one month, the calendar intermittently and randomly changes appointment times (i.e.,
1:00PM becomes 2:00PM). I will probably buy a
Hewlett Packard iPAQ but there are many choices.

Handheld Computing (PPC & Palm devices)
Mobility (mobile and wireless)
Pen Computing (mobile computing &
communications)
PocketPC (Windows Mobile PPC reviews,
comparisons, & smartphones)
Wireless (wireless communications)

Pocket PCs and cell phones have teamed up and are
called smartphones. These devices use the Microsoft
Windows Mobile for Smartphone software. The
smartphones have to make some compromises in
their form and function. To learn more about Pocket
PCs or to make a purchase, check out the following.
My favorite is the Pocket PC magazine (their 2004
Buyer’s Guide is available now).

Websites
amazon.com
hpshopping.com
mobileplanet.com
PocketPCmag.com
pcconnection.com
tigerdirect.com
There is no restriction against any non-profit group using this
article as long as it is kept in context with proper credit given the
author. The Editorial Committee of the Association of Personal
Computer User Groups (APCUG), an international organization
of which this group is a member, brings this article to you.
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Submissions to the BBS should be uploaded to the Newsletter Conference and a message left
for the Editor. Files should be straight ASCII, unformatted, with C/R only at end of
paragraphs; no indents for paragraphs should be used. Preferred format for diskettes is MSDOS 3½ 720k or 1.44Mb. Diskettes in other formats may be submitted but there will be a
considerable delay in processing. If absolutely necessary, items may be submitted in hardcopy
only but these will also meet with delay.

Membership Policy
The National Capital Tandy Computer Users Group, Inc. is a non-profit [501-c(3)]
organization founded in 1977 to educate users of all Tandy computers and MS-DOS
compatible computers. Membership dues are $25.00 (U.S.Funds) per year, with a $5 surcharge
for international mail. Membership in NCTCUG includes membership in all SIGs, access to
the BBS and software libraries, and subscription to the Journal published 10 times per year.
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.
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Reprint Policy
Permission to reprint articles from the NCTCUG Journal is given to school, personal computer
club, and nonprofit organization publications, provided that: (a) NCTCUG Inc. receives a copy
of the publication; (b) credit is given to the NCTCUG Journal as the source; (c) the original
author is given full credit; and (d) the article author has not expressly copyrighted the article.
Recognition is one means of compensating our valued contributors

Newsletter Staff
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Blair Jones
202-362-7344
bjones44@bellatlantic.net
Exchange Newsletter and
Articles Editor
Ron Schmidt 301-577-7899

COMPUCENTER BBS
Is no longer in operation. It has
been replaced by the
‘compucenter’ mailing list at
http://groups.yahoo.com/

If you are moving
Please send your change of
address to the club PO
box as soon as possible to
avoid missing issues.

Thank You!
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Rebates, Rebates, Rebates
When I look back at the last four or five months, I begin
to think I need to find a 12 Step group for Rebate-a-holics.
Here’s the pile: Norton Internet Security; Audiobahn CDRs; Turbotax Deluxe / Quicken Deluxe; Turbotax Federal
eFile; State eFile; Turbotax State; Norton AntiVirus;
Nova Development’s Art Explosion 600,000. These items
totaled $394.69, and I’m expecting checks for $184.94 in
rebates - almost 47% savings. I won’t mention the other
$27 I missed ‘cause I didn’t follow my own rules i.e., apply for rebates the same day you buy stuff! It’s hard to
convince me it’s not worth 15 minutes to fill out the coupons, clip the proof of purchase seal or bar code strip from
the box, and use the scanner to make a couple of copies.
I recently “invested” in a Toshiba laptop - it appeared in a
CompUSA 20th Anniversary ad with a special series of
rebates in one Friday’s POST. Rebates included $100
from Toshiba, $150 from CompUSA, plus another $100
from CompUSA to price match the same computer offered by Circuit City in the Sunday ads. Then, there was
the $187 in free merchandise I was able to select as part of
the Anniversary Sale. That provided a Belkin Wireless
Router / 4 port switch, and a wireless LAN card.
My other big weakness is restaurant discount coupons.
“My name is Paul.............”
[Ed. Note: The paid version of WeatherBug allows you to
keep a list of several locations to choose from — handy if
you have activities in different parts of the metro area! I
don’t know if the free version has the same option.]

NCTCUG, Inc.
P.O. Box 949
Arlington VA 22216

June/July 2004
1st Wed. (6/2, 7/7) 7 p.m.
Virginia General Meeting
4th Wed (6/23, 7/28) 7 p.m. Internet SIG
No meeting Christmas Eve!
Happy Holidays
3rd Monday (7/19, no meeting in June) 7 p.m.
Board of Directors

All meetings are at Carlin Hall, 5711 S. 4th
St., Arlington VA: East off of Carlin Springs
Rd, just south of Arlington Blvd/Route 50.

